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COPYRIGHT 
 

Copyright ©2011 by Hawking Technologies, Inc. All rights reserved. No part 
of this publication may be reproduced, transmitted, transcribed, stored in a 
retrieval system, or translated into any language or computer language, in 
any form or by any means, electronic, mechanical, magnetic, optical, 
chemical, manual or otherwise, without the prior written permission of this 
company 
 

LIMITED WARRANTY 

 
Hawking Technology guarantees that every HMPS1u 1-Port USB 2.0 Print 
Server is free from physical defects in material and workmanship under 
normal use for one (1) year from the date of purchase.  If the product 
proves defective during this one-year warranty period, call Hawking 
Customer Service in order to obtain a Return Authorization number.  
Warranty is for repair or replacement only.  Hawking Technology does not 
issue any refunds.  BE SURE TO HAVE YOUR PROOF OF PURCHASE.  
RETURN REQUESTS CAN NOT BE PROCESSED WITHOUT PROOF OF 
PURCHASE.  When returning a product, mark the Return Authorization 
number clearly on the outside of the package and include your original proof 
of purchase. 
 
IN NO EVENT SHALL HAWKING TECHNOLOGY’S LIABILTY EXCEED THE 
PRICE PAID FOR THE PRODUCT FROM DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF 
THE PRODUCT, ITS ACCOMPANYING SOFTWARE OR ITS DOCUMENTATION.  
Hawking Technology makes no warranty or representation, expressed, 
implied or statutory, with respect to its products or the contents or use of this 
documentation and all accompanying software, and specifically disclaims its 
quality, performance, merchantability, or fitness for any particular purpose.  
Hawking Technology reserves the right to revise or updates its products, 
software, or documentation without obligation to notify any individual or 
entity.  Please direct all inquiries to: techsupport@hawkingtech.com 
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Federal Communication Commission 
Interference Statement 

 
FCC Part 15 
This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:   
 

1. Reorient or relocate the receiving antenna. 
2. Increase the separation between the equipment and receiver. 
3. Connect the equipment into an outlet on a circuit different from that 

to which the receiver is connected. 
4. Consult the dealer or an experienced radio technician for help. 

 
FCC Caution 
 
This equipment must be installed and operated in accordance with provided 
instructions and a minimum 20 cm spacing must be provided between 
computer mounted antenna and person’s body (excluding extremities of 
hands, wrist and feet) during wireless modes of operation. 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to 
the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, 
including interference that may cause undesired operation. 
  
Any changes or modifications not expressly approved by the party 
responsible for compliance could void the authority to operate equipment. 
Federal Communication Commission (FCC) Radiation Exposure 
Statement 
 
This equipment complies with FCC radiation exposure set forth for an 
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uncontrolled environment. In order to avoid the possibility of exceeding the 
FCC radio frequency exposure limits, human proximity to the antenna shall 
not be less than 20cm (8 inches) during normal operation. 
 
The antenna(s) used for this transmitter must not be co-located or operating 
in conjunction with any other antenna or transmitter. 
 

R&TTE Compliance Statement 
 

This equipment complies with all the requirements of DIRECTIVE 1999/5/EC 
OF THE EUROPEAN PARLIAMENT AND THE COUNCIL of March 9, 1999 on 
radio equipment and telecommunication terminal Equipment and the mutual 
recognition of their conformity (R&TTE). 
 
The R&TTE Directive repeals and replaces in the directive 98/13/EEC 
(Telecommunications Terminal Equipment and Satellite Earth Station 
Equipment) As of April 8, 2000. 
 
Safety 
 
This equipment is designed with the utmost care for the safety of those who 
install and use it. However, special attention must be paid to the dangers of 
electric shock and static electricity when working with electrical equipment. 
All guidelines of this and of the computer manufacture must therefore be 
allowed at all times to ensure the safe use of the equipment. 
 
EU Countries Intended for Use 
 
The ETSI version of this device is intended for home and office use in Austria, 
Belgium, Denmark, Finland, France, Germany, Greece, Ireland, Italy, 
Luxembourg, the Netherlands, Portugal, Spain, Sweden, and the United 
Kingdom. 
The ETSI version of this device is also authorized for use in EFTA member 
states: Iceland, Liechtenstein, Norway, and Switzerland. 
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Chapter1  Introduction 
 
Thank you for purchasing the HMPS1u Multifunction Print Server (in the 
following referred to as “Server”). This Server is designed to connect your 
printers, Multifunction Printers, Scanners, Fax, and USB hard drives, 
allowing all network users’ access to these shared USB devices. 
 
1.1 What is described in this Manual 
 
This manual provides introductory information as well as detailed 
instructions on how to set up and manage the HMPS1u in various network 
environments.  
 
To fully benefit from this document, you should be familiar with basic 
networking principles. The instructions described in this manual are based 
on the settings in a new Server. To reload the Factory Parameters, you can 
reset this Server back to Factory Default, which will restore most of the 
settings. For details, please refer to the chapter “Restore Factory Defaults”.  
 
1.2 Customer Support 
 
Should you require any technical assistance, please contact your product 
reseller. Or you can visit our website at http://www.hawkingtech.com for 
latest product information.  
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Chapter2  Product Overview 
 

2.1 Package Contents 
 
Verify that nothing is missing from the package by using the checking list 
below. Please contact your dealer if anything is missing or damaged. All 
packing materials are recyclable. Please confirm the items in the package 
below: 
 

 This Server (HMPS1u) 
 CD (Hawking Multifunction Print Server setup software, User’s 

Manual and Quick Installation Guide) 
 Power Adaptor 

 
2.2 Product CD 
 
This CD provides easy-to-use multifunction print server software, User’s 
Manual and Quick Installation Guide.  
 
2.2.1 Start-up Procedures  

If your computer is configured to auto start CDs, this CD will start 
automatically when inserted. You can also navigate to the CD and start the 
autorun.exe file from within the Windows file manager.  
 
2.3 Physical Description 
 

1. Power Adaptor Connector: for DC IN 12V/1A power adaptor 
2. Init Button: for restoring the parameters to the default values   
3. Ethernet Connector: connected to a twisted pair category 5 cable 
4. USB Host Ports: USB 1.1/2.0 low, full, and Hi-Speed compliant 
5. Indicators 
 Power Indicator is lit while power is applied. If it is not lit, or if it blinks, 

there is a problem with this Server or power adapter.  
 Link Status is lit while network is applied. If it is not lit, it indicates 

that this server does not connect to the network.  
 Status Indicator blinks to indicate network activity. 
 LAN Indicator blinks to indicate wired network activity. If it is lit, it 

indicates the wired network is applied. If it is not lit, it indicates that 
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the server does not connect to the wired network.  
 USB Indicator lit while a USB device connects to a USB Port of this 

Server. If it is not lit, or if it blinks, there is a problem with the USB 
device or this Server. 

 
2.4 Supported USB Devices 
 
The HMPS1u supports the following types of USB devices. 
 
 USB Printer 
 USB multifunction printer (MFP/AIO) 
 USB scanner 
 USB storage (like USB external HD, flash disk, and digital camera) 
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Chapter3  Basic Installation 
 

3.1 Connecting the Hardware  
 

1. Make sure that your USB devices are switched off and that the 
Server’s Power Adapter is disconnected. 

 
2. Connect the USB devices to the USB ports with the USB cables.  

 
3. Connect the Server to the network with a twisted-pair category 5 

cable, 10baseT or 100baseTX.  
 
4. Turn on the USB devices and make sure it is ready for use.  

 
5. Connect the Power Adapter to the Server. The power indicator will 

light up and the USB indicator will flash in turn. When the Link 
indicator lights up, the Server is correctly connected to the network. 
When the USB indicator stops flashing, the Server starts to work 
normally.  

 
3.2 Assigning an IP Address to the Server  
 
3.2.1 Preliminary 

 If you have a DHCP server on your network, your Server will receive 
an IP address automatically. The IP address will then appear on the 
setup software when it detects your print server. If your DHCP server 
does not give an IP address to the Server, the Server will use the 
automatic private IP addressing IP: 169.254.0.0. ~ 
169.254.255.255  

 
 If you are not working in a DHCP network, you need to manually set 

the Server’s IP address. 
  

3.2.2 IP Address  

Unless you are assigning an IP address using DHCP, you must obtain an 
unused IP address from your network administrator.  
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3.2.3 Methods for Setting the IP Address  

You can set the IP address of your Server using one of the following methods, 
depending on your network operating environment:  
 

 Automatic IP Address Assignment  
 

 Manual IP Address Assignment  
 

3.2.4 Server Names and Server Name Rules 

The default server name of the Server is “HMPS1U”.  If you put two or more 
Servers in your local area network, to avoid using the same server names 
you have to change the server names by using the setup software or the 
server’s web pages. If your server name is longer than 15 characters, the 
server uses only the first 15 characters.  

 
3.2.5 Setting the IP Address Using DHCP 

Follow the instructions below to get an IP address using DHCP:  
 

1. Edit or create a scope in the DHCP manager of the DHCP daemon. The 
entries included in this scope should contain the following parameters:  
 range of IP addresses  
 subnet mask  
 default router IP address  
 DNS server IP address  
 lease duration  
 

2. Activate the scope. The Server automatically gets the DHCP 
parameters. If you are using DNS, you may include at least one DNS 
server IP address in the DHCP scope or manually set the DNS server IP 
address using Server’s web pages or the HMPS1u’s setup software.  

 
3.2.6 Setting the IP Address Using the HMPS1u Software 

 
1. Install the Setup Software. The Setup Software is available on the 

Product CD. 
 
2. Start the Hawking Print Server software window will appear.  It will 

appear until Start, Programs, Hawking, Multifunction Print Server 
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3. If the tool finds multiple Servers in your local area network, you will 
have to select one Server from the Server List.  

 

 
 

4. Double click the highlighted server (or click the “Configure Server” 
button.  This will open a web browser showing the web interface of 
the HMPS1u. Click the “CONFIG” button. 
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5. Login with administrator ID (default: admin) and its password (default: 
admin). 
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6. Click the button corresponding to your choice of IP setting methods 
(static or dynamic using DHCP). When assigning a static IP address 
you also have to define Subnet Mask.  The default IP of the HMPS1u is 
192.168.1.100 

 
7. Click Submit to save your settings. And the Server will reboot. You 

have now finished the procedure of setting the IP address.   
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Chapter4  Using the HMPS1u 

 

4.1 Introduction 
 
The goal of this product is to provide network support for USB devices. We 
developed a new technology called “NetUSB” to achieve this goal. Basically, 
the “NetUSB” is a “USB over IP” technology that transparently redirects all 
USB packets to a TCP/IP network channel. “NetUSB” allows you to use USB 
devices as if they were connected directly to your PC although they are 
actually remotely connected to the HMPS1u. 
 
4.2 Connect & Disconnect 
 
“NetUSB” allows you to use USB devices as if they were connected directly to 
your PC although they are actually remotely connected to the HMPS1u. The 
“connect” operation is a software operation that simulates an actual USB 
device plug-in. That is to say, when you do a “connect” operation in the 
HMPS1u setup software, the PC can then detect a USB device’s plug-in, even 
though you did not physically plug in a USB device to your computer. 
Similarly, the “disconnect” operation is a software operation that simulates 
the disconnection of the USB device. Once the connect operation is 
successful, the operations to use that USB device are just the same as if the 
USB device is directly connected to the PC. 
 
If a USB device is “connected” by a PC, we say that PC has the ownership of 
the USB device. Only one PC can get the ownership of a USB device at the 
same time. Therefore, if a USB device is connected by one PC, no other PC 
can connect this USB device until this USB device is disconnected. 
 

4.3 Subnet Issue 
 
Before using the NetUSB technology, you must first make sure that your PC 
can access the HMPS1u via TCP/IP. The simplest way to do this is using 
HMPS1u’s setup software to search for the HMPS1u server on the network 
and change its IP address to be the same subnet as your PC. If the server 
and your PC are not in the same TCP/IP subnet, the HMPS1u’s setup software 
will show the server in red, as shown in the following figure. You must 
change the IP address (or use DHCP) of the server so that the server and 
your PC are in the same subnet. The HMPS1u setup software will show these 
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servers in blue, meaning you can access these servers by the NetUSB 
technology. 
 

 
 

4.4 Installation of a Printer/Multifunction 
Printer/Scanner  
 
Some USB devices, like printers or MFPs (multifunction printers), require you 
to install manufacturer provided driver (usually included on the printer’s 
CDROM).  

 
A. Insert the printer’s CDROM into the CD drive and run the “install 

program”. 
B. Follow the instructions of the installation program to install driver. 
C. When the installation program asks you to plug-in the USB device, run 

the “Hawking Print Server” software. 
D. In the Hawking Print Server” software, select the HMPS1u that has the 

desired USB device attached. 
E. Click the desired USB device as the following figure. 

 

 
F. Click the “Connect” button. Then the message “Manually Connected by 
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your_computer_name” will be shown, as the following figure. 
 

 
 

G. Now, the installation program will detect the USB device and continue to 
install driver. 

H. After the installation is completed, click the USB device in the HMPS1u 
Software and then click the “Disconnect” button to disconnect the USB 
device. 

 
Now the driver of your USB device is installed. 
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4.5 Auto-Connect Printer 
 
The method described in section 4.4 is called manual-connect, which means 
users must manually connect the USB printer before using that device, and 
must manually disconnect the USB printer device after using the printer, 
otherwise no one else can connect. However, for printers and scanners (and 
MFPs), the HMPS1u supports auto-connect so users don’t need to manually 
connect/disconnect. This and the next sections show you how to do this. 
 
After the driver is installed as described in section 4.4, you can see a newly 
created printer in the setup software’s “Printers and Faxes”. Follow the steps 
below to do a NetUSB auto-connect printing. 
 
A. In the HMPS1u software, click the USB device server that has the desired 

printer (or MFP) attached. 
B. Click the desired printer (or MFP). 
C. Click the “Auto Connect Printer” button and choose “Set Auto-Connect 

Printer”. 
 

 
 
The following figure will appear. 
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D. Choose the desired printer. The desired printer must be the Windows 
printer (this is a logical printer) that matches the printer attached on the 
USB device server (this is a physical printer). Then click the “Apply” 
button. 

E. The printer will then be marked as an “Auto-Connected Printer” in red. If 
you choose “Auto-Connected Printer List” in the “Tools” menu, you can 
see a newly created item that describes the association between the 
Windows printer and the physical printer on the server. 
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F. Try to issue a print job to the desired printer. You will see the HMPS1u will 
automatically do a connect operation and allow you to print. 

G. Even you already properly setup an auto-connected printer, the HMPS1u 
software must be running (in the background) while a print job is issued. 
This means you should have the HMPS1u software run every time after 
you login to Windows. In order to skip this manual operation, you can 
make the HMPS1u run automatically after you login Windows. To do this, 
choose the “Configuration” item in the “Tools” menu. The following 
window will appear. Click on the check box and then on the “OK” button. 
This feature is enabled by default. 

 

 
 

If you would like to break the association between the Windows printer and 
the physical printer, just click on the association and click the “Delete” button 
in the “Auto-Connected Printer List”. 
 
4.6 Network Scanner 
 
For NetUSB scanning, we recommend you use Network Scanner as the 
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following steps. 
 
A. In the HMPS1u software, click the HMPS1u that has the desired MFP (or 

scanner) attached. 
B. Click the desired MFP (or scanner). 
 

 

 
 

C. Click the “Network Scanner” button. Then you can see that the HMPS1u 
will automatically do a “connect” operation. The following window will 
appear. 

 

 
 

D. Choose one of TWAIN or WIA item. Click “OK”. The following window will 
appear. 
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E. Follow the usual steps to do scanning. 
F. After the scanning, close the “Auto-Connect Scanner” window.  
 

4.7 USB Storage 
 
You must use “manually connect” for USB storage. If the USB storage is a 
flash drive, the new disk is a “removable disk”. 
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You can see the storage icon in the system tray. 
 

 
 

Then just use the new disk as a general disk. After you finish the disk 
operations, click the storage icon in the system tray and choose “Eject USB 
Mass Storage Device” to remove the USB storage, as the following figure. 
 

 
 
Then, in the HMPS1u software, click the USB storage device and click the 
“Disconnect” button to disconnect the USB storage device. 
 

4.8 Request to Connect 
 
If a USB device is manually connected by another user on the network, you 
cannot use the device until they disconnect. We offer a mechanism to notify 
the other user.  It is called “Request to Connect”. The user on one computer 
can click the “Request to Connect” button in the HMPS1u software. The 
following window appears. 
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At this moment, the user on the other computer currently connected to the 
HMPS1u will see the following window: 
 

 
 
The user will choose to accept or reject. If accepted, the HMPS1u user will 
automatically disconnect and the other user will automatically connect. 
 

4.9 Quitting the HMPS1u Setup Software 
 
The HMPS1u setup software doesn’t really quit if you click the “X” box (close 
box) at the top right corner of the window. Instead, it just minimizes itself to 
the system tray. There are two ways to really close the software. The first 
way is choosing “Exit” item in the “File” menu in the software. The second 
way is right-clicking the icon of the software in the system tray and choosing 
the “Exit” item. 
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4.10 Limitations 
 
There are some limitations to use the NetUSB technology. 
 
A. Only supports Windows 2000/XP/2003/Vista/7. Windows 98/ME are not 

supported. 
B. Only one PC can get the ownership of the same USB device at the same 

time. 
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Chapter5  The Server’s Web Pages  
 

5.1 Introduction 
 
The HMPS1u has a web user interface.  Users may use the web pages to see 
the HMPS1u’s system status and configure the device.  You may access this 
page by running the HMPS1u’s software and clicking configure or by directly 
typing in the IP address of the device into your web browser. 
 
5.2 Using the Server’s Web Pages 
 
5.2.1 Displaying Server Status 

Click on the “STATUS” icon to see system status and network status. 

 
 System Status 

 Firmware Version: the current version of the firmware of the 
device 

 Model Name: the model name of the product 
 Mac Address: the machine address of the HMPS1u 
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 Network Status 
 Server Name: the network name of the HMPS1u 
 Storage Access Mode: which storage mode the HMPS1u is in 
 IP Address: the current IP address of the HMPS1u 
 Subnet Mask: the current subnet mask of the HMPS1u 
 DHCP Server: the gateway of the HMPS1u 
 Lease time: if using DHCP, how long the IP address has been 

assigned.
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5.2.2 Setting up Server Configuration 

To set up the Server configuration, click on the “CONFIG” icon ad then the 
system will request user to enter administrator (default: admin) and 
password (default: admin) to login.  

 
 General 
 
Server Information: You have to set the Server Name, which is the 
name to represent the Server. 

 

 
 Server Name: The network name of the HMPS1u. 
 Workgroup: The workgroup name of the HMPS1u 
 Description: This is an optional setting so you can put in a 

description of the device for your network settings. 
 

Storage Access Mode: allows for the USB hard drive configuration 
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 Server Mode: Allows multiple computers in your network to 
connect to the USB storage device at the same time.  Device 
will appear on the network as a shared drive. 

 NetUSB Mode: Only allows on computer at a time to access the 
drive. 

TCP/IP 
 TCP/IP: You have to set the Server’s TCP/IP configuration to 

connect TCP/IP network. Please see Chapter 3.2 for more 
details. 

UPnP Setting: Enable or disable the UPnP function. 
 

 
 Administrator: You can change administrator name and password. 

If you forgot administrator name and password, you must perform 
Restore Factory Default action by plugging in the power adaptor 
while pressing the Init button. Please refer to the chapter “Restore 
Factory Defaults”. 
 Administrator: enter your desired administrator name. 
 New Password: enter your desired password. 
 Re-type Password: re-confirm the password. 
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 Maintenance If you want to restore factory default values of the 
Server or upgrade new firmware, you can use the Maintenance tool. 
 Restart: click this button to restart (reboot) the Server. 
 Factory Default: click this button, the Server will restore 

factory default values. 
 Firmware Upgrade: click Browse to find the firmware file to 

be upgraded. Click Upload to upload the firmware into the 
Server. 
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Chapter6  Troubleshooting 
 
This chapter provides useful information to help you resolve difficulties that 
you may experience with your Server. Fault symptoms, possible causes, and 
remedial actions are provided within a quick reference table. This Server’s 
USB ports only support MFPs, printers, scanners, and USB mass storage.  

 
6.1 LED Indicators 
 
 

Indicators Behavior Description 
Power On Power On 

Off Power off/System error 
Link On Network connected 

Off No physical connection to network 
Status Blinking Activity on network 

Off No activity on network 
USB On USB device connected 

Blinking Connected USB device error  
Off No physical connection to USB device 

 
6.2 Firewall 
 
If firewall software has been installed on your PC, it may block the 
communication between the PC and the HMPS1u so that the HMPS1u cannot 
work properly. To solve this problem, either disable the firewall or configure 
the firewall to allow the following TCP and UDP ports: 
 
7303, 7305, 20005, 30201, 30202, 30203
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Chapter7  Restore Factory Defaults 
 
You may restore the HMPS1u default parameters by one of the following 
methods. 

 
7.1 Using the Server’s Web Pages 
 

1. Go to the Server’s web page and click CONFIG  
 
2. Enter administrator (default: admin) and password (default: 

admin). 
 

3. Click Maintenance. 
 
4. Click Factory Default. 

 

 
 

5. Click Yes to confirm 
 

7.2 Using Init Button 
 
Plug in the power adaptor while pressing the Init button until the USB 
indicators blink.  After that, plug off the power adaptor and then plug in the 
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power adapter again to restart the Server. Finally, the Server will operate 
using the Factory Default values.  
 
7.3 Default Parameters List 
 
General Information 
 Server Name: HMPS1u 

 
TCP/IP 
 Automatically get IP by DHCP: Enabled 
 Static IP: Disabled 

- IP Address: 192.168.1.100 
- Subnet Mask: 255.255.255.0 

 
User Accounts 
 Administrator: admin 
 Password: admin 



 
 

 
 

34

 

Chapter8  Upgrade Firmware 
 
This chapter describes how to upgrade firmware. Please follow one of the 
following Procedures:   
 

Procedure A: Using the HMPS1u Software 

1. Download the firmware from www.hawkingtech.com.  Save the 
firmware to your desktop. 

2. Open the HMPS1u setup software. It will automatically search the existing Servers 
and display their statuses.  

3. Select the Server that you want to upgrade the firmware. Double click the 
selected Server to get into the HMPS1u’s web page.  Check the system 
status page to make sure you need an upgrade. 

4. Click CONFIG icon. 
5. Login the Server with Administrator (default: admin) and Password 

(default: admin). 
6. Click Maintenance. 
7. Click Upgrade Firmware. 

 

 
 

8. Click Browse button to choose the file of new firmware. 
9. Click Upload button to start firmware upgrade. 
10. Wait for 20 seconds for system reboot. 

 
Procedure B: Using the Init Button and the TFTP Client  

1. Plug in the power adaptor while pressing the Init button until the USB 
LED indicator blink. Please note that after that, the HMPS1u will 
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operate using the factory default values after restarting. 
2. Run the TFTP client Tool: Image Burner, from Windows Start menu. 
3. Click Open Image to open your new firmware. Please note that you 

must configure your PC’s TCP/IP such that PC and the HMPS1u belong 
to the same LAN, i.e. PC’s IP is 192.168.1.xxx and subnet mask is 
255.255.255.0. 

 

 
 

4. Click Upload Image. 
5. Wait for Image Uploading to finish and then click Close. 
6. Unplug the power adapter and then plug-in the power adapter to 

restart the HMPS1u. 
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Chapter9  The Init Button 
 
The Init button is used for maintenance:  Simultaneously press Init button 
and turn on (by plugging in the power adaptor) the HMPS1u until the USB 
LED indicator simultaneously blink. After that, the HMPS1u will do the 
following tasks: 
A. Perform a Factory Default restoration of the HMPS1u, which will restore 

most of the parameters and settings to factory default values. 
B. Perform a TFTP server. You can upgrade new firmware using any TFTP 

client tool. 
 
Note:  After performing the tasks mentioned above, you have unplug and 
then plug in the HMPS1u so it will complete the task. 
 
 


